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Welcome to OpenXDF

The Consortium would like to thank everyone that has participated in the OpenXDF fndreseryoe who has
given us direct feedbaakver thepast couple ofears Your constructive criticism and insights have contributed
greatly to the developme of OpenXDF, XDFviewer, anthaXimus

Changes iversion 1.0

Packaging,Compression and Encryption

Prevous versions of the specification allowed for proprietary compression and encryption with the understanding
that such methods would render the file unusable by other systems.

It became obvious that using OpenXDF to exchange data between researchiealdirtdititutions would require
standardized and secure methods of encrypting sensitive information for transport. This version of the specification
introduces the ability to secure OpenXDF files using strong, pasdvesedl woFishencryption.

Experiene with OpenXDF in the field highlighted the utility of being able to store sections of an OpenXDF header
separately. This version of the specification introduces packaging sections that provide details on how to use ZIP

with DEFLATE to package and compsesiultiple OpenXDF headers, and other types of files, into a single file that
all compatible systems will be able to handle.

XML

This version of the specification explicitly restricts the OpenXDF headers te8ArFRUTF16 encodingo ensure
maximal comp#bility between XML parsers.

Data Storage

Previous versions included a number of artificial limitations left over from the original develop@&nple size,
sample frequency, and frame lengtle no longer constraineand OpenXDF now includes the atyilto specify the
byte order of multbyte samples.

Montages

Since the specification no longer includes limitations on sampling frequencies, the specification now includes a
minimal set of sampling frequencies for the highd lowfrequencyfilter types The specification also includes a

new notch filter requirement.

Previous versions of the specification included a ATyp
confusion in the forums since the type names listed were propridiagddition there was some confusion over

how to display events like the XDFviewer using the channel type.

This version of the specificatiamses standard names for the channel types and includes a table that specifies how
event typeselateto channel typs.

Patient Information

The patient information section now includesgngicant amount of additionahformation.
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Video
OpenXDF now includes support for referencing video associated with a record.
American Academy ofSleepM edicine Guidelines

OpenXDF now includesupport for thenew AASM guidelines.

Changes in Version 1.1

XML

82.1.1.30f the specificatia now explicitly requires that systems read and write values using the POSIX locale
defined in IEEE 1003.1, 200&hen not governed by any other requiremeniBhis requirementspecifically
addresses an issue that arises when exchanging OpenXDF files rbetystems using locale settingsthw
conflicting decimal symbols (A9.3450 vs. @9, 3450) .

Changes in Version 1.2

XML

82.1.1.40of the specificatiomow requiressystems that read and write OpenXDiles retain any well-formed,
unrecogized tags locationwithin the hierarchy namespace, name, and @t and write the tagndits contents
back out verbatim.

Event Display

83.1.13is now an optional guideline for consistent event display.
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1 Introduction

The fundamental motivation behind OpenXDF is to provide the raeda@mmunity with an open standard for the
exchange of timseries data such as electroencephalograph (EEG), electrocardiogram (ECG), and oximetry signals.
The OpenXDF standard also serves as a vehicle foligheweight exchange of patientand domairspecific
metadata, such as patient demographics and polysomnography scoring information, with or without signal data.

At its most basic level, an OpenXDF file is a XMiased header file that provides all of the information necessary
to interpret a signalata file. This abstraction allows OpenXDF serverenadvanced functions such lasing a
superset to existing format§2.1.1.5; allowing multiple signal data files, possibilibf different formats, to coexist

as a single unit; and metadata exchange.

1.1 Conventions

A byteis a singleoctetof bits.

The cardinalityof an XML tag is a constraint on the number of times a tag may occur wvatlgivencontext. A
fi r e q utagrskali accur exactly ongeithin a contextwhilea n  fi o pthg ntay acdudat most onedthin a
context The specification will express the cardinality of a tag thatyroccur more than once withircantext using
interval notation

Figurelillustrates the formatting used for XML and code blocBéue text indicates an example value

<xdf:OpenXDF>
<xdf:EpochLength> 30 </xdf:EpochLength>
<xdf:SessionContinuity> false  </xdf:SessionContinuity>
<xdf:DataFiles />

</xdf:OpenXDF>

Figure 17 Example XML Block

1.2 Organization

OpenXDF is a tiered framework designed to allow standardized and custom specializations of the format while
enforcing a common foundation that provides a Haylel of compatibility betweennrelated systems.

OpenXDF Level 1 defines the absolute minimum requirements for a functional OpenXDF file.
OpenXDF Level 2 defines advanced features common to most specialties.

OpenXDF Level 3 defines specializations of the standard. Level 3 stardentdén the name of the specialization
to which they apply. ALevel 3.PSG,0 for instance, i
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2 Implementation Standards
2.1 Level 1

2.1.1 System Requirements

2.1.1.1 Packaging

Systems may package and/omgmessone or moreOpenXDF headers, as well as any secondary files such as a
patient photointo a single file usinghe ZIP file format and thddEFLATE compression algorithm.

When packaged in a ZIP file, systesiwll store hte main OpenXDF header the root of the package and name it
fi h e ad e rLater cdctioids will discuss when it is appropriate to pgekeultiple OpenXDF headers and
secondary files togetheanddiscusshow to organize the package in a standard way.

2.1.1.2 Encryption

Systems may encrygpenXDF headersr packagesising TwoFish in Cipher Feedback (CFB) modeWhen
encrypting with TwoFish, systems shall 8dA-256to hash glain text, UTF8 encodedpassword into a 25bit
encryptionkey anduseSHA-512to calculate &12-bit checksum of theriginalfile.

While TwoFishis a 128bit block cipher, TwoFish operates as a streggher in CFB modeliminating the need for
a padding scheme to align the input on-b&&oundaries.

Cipher feedbackhall be primed with 428 bit initialization vector (V). Since the IVhust be publicthe IV should
beauniqueseries of bytes generated at the time of encrygtiavoid security issues related to using the same key
IV pair more than once Generating a neWwUID before encrypting is one way tvoid key-IV collisions when
choosing an IV.

Encrypted files shall begin witthe OpenXDF encryption headsiown inFigure2. All fields are big endiarand
aligned on 1byte boundaries

OpenXDFEncryptionHeader

{
/* identifies an encrypted OpenXDF header/package ; setto  0x53 584446. */

Uint 32 Magic;
/* size of the header ; set to 96 bytes. */
UInt3 2 HeaderSize;
[* the cipher feedback initialization vector X
Uint8 | nitialization Vector [16] ; ;
/ SHA 512 hash of the original file ¥
Ulnt 8 Checksum[ 64]; i
/* Applicatio  n- specific data. */

UInt64  ApplicationData

Figure 217 OpenXDF Encryption Header
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Systems shall only apply encryption after packaging/compression.

2.1.1.3 XML and Entities

Reading systems shamploy an XML parser that adheres to YW8C XML version 1.0standard. XDFvieweand
maXimususeMi c r o free KML6Gore Services (MSXML) 4.Go implement aSimple API for XML (SAX)
parser. There aralsoseveralbpensource crossplatform parsers available suche§atandlibxml.

Likewise, writing systems shall write OpenXDHReB in a manner that conforms to the XML version 1.0 standard
and shall only use UTF-8 or UTF-16 encoding to ensure maximum coatipility between XML parser
implementations.

When not governed by the XML specification, UBF16, or any specific requirements in this specification (such as
the use of ISE601 for date/time values), systems shall read and write values using the R@3IX defined in
chapter 7of IEEE 1003.1, 2004

Systems shall be backward and forward compatible with all versions of the OpenXDF spetitatimg wih
version 1.0.

If this specification does not explicitly indicate the order of list items using a timestamp, epoch number, etc.,

systenss hal | rely on the order in which list items appear
sourceistofasignald at a fil e, then AA10 precedes AC30 in the sigr
Unless otherwise specifiedll values arecasen sensi ti ve. For instance, AC30 i s

2.1.1.4 Unrecognized an@€ustom Tags

In addition to the standard tagsnplementersmay also use custom tags Custom tagsshall include an
implementatiorspecificnamespaceCustom tagshall not use théixdfo namespace.

Reading systems may safely ignore wielimed, but unrecognized, tags. For instarceystem designed to only
understand Level OpenXDFmay safely ignore Level 2 tags custom tags from another implementation.

Systems that read and write OpenXBles, however,shall retain any well-formed, unrecogized tags location
within the hierarchy namespace, name, and @it and write the tagndits contents back out verbatim.

2.1.1.5 Data Frames

A data frame is a collection of signal data blqchkigned on dbyte boundarieswhere each signal data block
contains the same duration of data. The signal data blocks stsitirbd in the same ordastheir sources in the
signal data fileds source 1|ist.

While OpenXDF does not constrain the length of a framplementers shouldarefully consider read performance
anddisplay requirementehen choosing a frame length. shot frame lengthmay force a reading system to fetch
samples using a large number of small disk operations, whilegdrame lengttmayimpose limits on epoch length
and displaytime bases

For many systems, a oisecond frame length provides a good nfixlisk access efficiency and display flexibility.

Figure3 illustrates aypical frame:
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1s Frame

1,000 Hz, 16-bit : {C3 (2,000 bytes)
1,000 Hz, 16-bit: | C4 (2,000 bytes)
1,000 Hz, 16-hit - | Al (2,000 bytes) :

1 Hz, 8-bit: | Sa02 (1 byte) ...next frame

Total Length: 6,001 bytes

Figure 317 Example Data Frame

2.1.1.6 Digital and Physical Ranges

While not a specific requement of this specificationmplementersshould pay particular attention to digital and
physical ranges.

OpenXDF and EDF efféiwely treat signals as though they have no.ufihe EDF header includes a text field for
specifying the unit of a signalThe field is notreliable, however, since it can contain any arbitrary unit or no unit at
al | . A signal és unit value in OpenXDF is simply a con:

Signalswithout a unitrequire some care when deciding their physical digital ranges.

Consider a signal that has a physical range-6frfillibars, 5 millibars] INnEDF,i t i s possi ble to spe
the unit field and rely on reading systemsstale the value on the screappropriately. Doing this, however,

assumeghat the reading systemnderstandi mb.@ r The reading system may only
recognize millbars at all.

Now consider a system that is able to dispdae unit per pixel vertically on the screen at a sensitivityoné
Withoutany knowl edge of the above signaldés wunit, the rea
vertical range of only 10 pixels at a sensitivityooieand less thatwo pixels at the nominal sensitivity sEven

I f instead, t h €008 migrabard, 5090 nnicaohags¢he logisal dquivalent to the same range

expressed in millibarsthe reading system would display the signal with a vertical range of 10,000 pixels at a
sensitivity ofonesincethe unit ofsensitivityis microbarsperpixel instead of millibargperpixel.

2.1.2 Header Requirements

An OpenXDF header file begins with the standard XML declaration including the XML versiotextrehcoding
schemeas shown irFigure4. As specified irg2.1.1.3 the encoding shall either be U'Bror UTF16.

Figure 41 XML Declaration

2.1.2.1 xdf:OpenXDFEntity

The xdf:OpelXDF entity, shown irFigure5, immediately follows the XML declaration and is the root element of
an OpenXDF header. The xdf: OpenXDF entity declares tt
required by the header.
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<xdf:OpenXDF  xmins:xdf= " http://www.openxdf.org/xdf

xmins:custom=
xmins:...

>

<xdf:EpochLength > 30 </xdf:EpochLength>

" organization/custom

<xdf:SessionContinuity > false  </xdf:SessionContinuity>

<xdf:DataFiles />
</xdf:OpenXDF>

_____________________________________

Figure 57 xdf:OpenXDF Entity ; Level 1

xdf:EpochLength

Data Type: Ulint8

Cardinality: Optional

Default: See Description

Description: Epoch (page) length in seconds.

This valueshall be a common integer multiple of the frame lengths spec
by the data files. An OpenXDF filshall not specify an epoch length th
would force a system to display partial frames in an epoch. The systeni
treat an invalid value as an errardestop processing the file.

If a header does not specify thEue, the system shall choose a value that
common integer multiple of the frame lengthgdfied in the data files and

between 10 and 60 secondsf any one of the frame lengths eeds 60
seconds, the epoch length shall be the least common integer multiple
frame lengths. The system shall treat the failure to determine a valid e
length as aminrecoverable error

xdf: SessionContinuity

Data Type: Boolean

Cardinality: Optional

Default: False

Description: Indicateshow systems shall calculapoch numbers across sessions. If

value is truesystems shall takdhe time between sessioim#o accaint when
calculating epoch numbers.

For example, consider Session A and Session B, and an epoch length
seconds. IfSession A is one hour longession B begins one hour aff
Session A ends and this value is true, the first epoch of Session B lveitdd
instead of 121.

xdf: DataFiles

Data Type: List of DataFileentities [0, +D)

Cardinality: Optional

Default: No default

Description: Defines a list of signal data files referenced by the header.

2.1.2.2 xdf:DataFile Entity
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<xdf:DataFile>

<xdf:Sources />
<xdf:Sessions />
</xdf:DataFile>

<xdf:File > EXAMPLE.RAWDATA/xdf:File>
<xdf:FrameLength > 1 </x df:FrameLength>
<xdf:Endian > big </xdf:Endian>

Figure 61 xdf:DataFile Entity ; Level 1

Data Type: Text

Cardinality: Required

Default: No default

Description: The signal data file nameTo avoid path convention issues across platfor,

systems should avoidbsolute and/ocomplex paths such a$NC paths and
URLs. Systems shall attempt to translate between Windows PAD8IX
conventions where possible.

xdf: FrameLength

Data Type: Floatingpoint

Cardinality: Required

Default: No default

Description: The data frame length in second®ystems shall treat a value less than or e
to zero as an unrecoverable err&ee§2.1.1.5

xdf: Endian

Data Type: Endian

Cardinality: Optional

Default: Al ittleo

Description: Specifies the byte order of muliiyte samples.

xdf: Sources

Data Type: List of Sourceentities [0, +D)

Cardinality: Optional

Default: No default

Description: Defines a list of sources in the signal data file.

xdf: Sessions

Data Type: List of Sessiorentities [1, +D)

Cardinality: Required

Default: No default

Description: Defines a list of recording sessions in the sigieth file. Sessions shall b

disjoint across all DataFile entities specified in the header.

2.1.2.3 xdf:Source Entity
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<xdf:Source>
<xdf:lgnore > false </xd f:Ignore>
<xdf:SourceName > C3 </xdf:SourceName>
<xdf:Signed > true </xdf:Signed>
<xdf:SampleWidth > 2 </xdf:SampleWidth>
<xdf:SampleFrequency > 1000 </xdf:SampleFrequency>
<xdf :DigitalMax > 32767 </xdf:DigitalMax>
<xdf:DigitalMin > - 32768 </xdf:Digi talMin>
<xdf:PhysicalMax > 3200 </xdf:PhysicalMax>
<xdf:PhysicalMin > - 32600 </xdf:PhysicalMin>
<xdf:DigitalToVolts > 0.09765774  </xdf:DigitalToVolts>
<xdf:Unit > 0.000001  </xdf:Unit>

</xdf:Source>

Figure 771 xdf:Source Entity

Data Type: Boolean

Cardinality: Optional

Default: False

Description: Indicateswhethersystems shall ignorde source.

Headers shall specify th8ourceName, SampleWidth, and Séefrrequeng
for ignored sources The SampleWidth and SampleFrequency values ma
arbitrary as long as their product equals the correct number ofibyaefsame

to skip.
xdf: SourceName
Data Type: Text
Cardinality: Required
Default: No default
Description: A name that uniquelidentifies this source within thiBataFileentity.

Systems shall treat any subsequent sources with a duplicate name as
their ignore flags are set to true.

Data Type: Boolean

Cardinality: Optioral

Default: True

Description: Indicates whether samplaresignedor unsigned.
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xdf: SampleWidth

Data Type: Uint8

Cardinality: Required

Default: No default

Description: Samplesizein bytes. Systens shall support sample sizes up to the integer

of ther target architectuse For example, 3bit systems shall suppoup to
32-bit (4 byte) samples, but are not végd to support larger samples

If a system encounters a sample size it does not support, the system sh
the source as thougduf:Ignore is true

Systems shall treat a value of zero as an unrecovezgble

xdf: SampleFrequency

Data Type: Uintl6

Cardinality: Required

Default: No default

Description: The sampling frequency, idz, for this source.

Systens shall treat a value of zero as an unrecoverable error.

xdf: DigitalMax

Data Type: Floatingpoint

Cardinality: Required

Default: No default

Description: Maximum value of the digital signal. Sg2.1.1.6
xdf: DigitalMin

Data Type: Floatingpoint

Cardinality: Required

Default: No default

Description: Minimum value of the digital signal. S82.1.1.6

xdf: PhysicalMax

Data Type: Floatingpoint

Cardinality: Required

Default: No default

Description: Maximumvalue of the physicadignal. Se&2.1.1.6

xdf: PhysicalMin

Data Type: Floatingpoint

Cardinality: Required

Default: No default

Description: Minimum value of the physicadignal. Se&2.1.1.6
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xdf

xdf:

Data Type: Floatingpoint

Cardinality: Optional

Default: 1.0

Description: Specifies a multiplier thasystems may ust® convert the digital range of
nonVoltage signal to Volts.
Consider an amplifier wit a DC input that outputs 0.01V increme
represented by signedyt samples.The full range of the input is:
[-128, 127]=[-1.28V, 1.27V].
Now consider a CPAP machine that outputs 0V to 1V representimgH20O,
30 cmH20. To display the dataroperly, the OpenXDF source woultkeda
physical min and max of 0 and 30 respectively, ardigital min and max
would be 0 and 100 respectively.
In this case, the xdf:DigitalToVolts value would 0.01.

Unit

Data Type: Floatingpoint

Cardinality: Optional

Default: 0.0

Description: Specifies the unit of a calibrated physical signal as a factor of Volts.
instance0.001 represents millivoltsFor norVoltage signals, this valughall
be 0.0

2.1.2.4 xdf:Session Entity

<xdf:Session>
<xdf:Offset > 1000 </xdf:Offset>
<xdf:.Length > 7201200 </xdf:Offset>

<xdf:StartTime

</xdf:Session>

'
L

> 2008- 07-015T22:00:00 .250 - 04:00 </xdf:StartTime>

Figure 81 xdf:Session Entity Level 1

xdf:

Data Type: Ulnt64

Cardinality: Required

Default: No default

Description: Specifies the offset, in bytes, from the beginning of the signal data file t
start of the session data.

Length

Data Type: Ulnt64

Cardinality: Required

Default: No default

Description: Specifies the legth,inbytes of t he sessionds si
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xdf: StartTime

Data Type: Date/Time

Cardinality: Required

Default: No default

Description: Specifies sessionbs start date an
2.2 Level 2

2.2.1 System Requirements

A level 2 compliant sysim shall adhere to all requirementgihl.1as well as the following requirements.
2.2.1.1 Packaging

Systems may package patigohotos into a packagki r ect ory named Aphottacsgnaylbe The n
arbitrary as |l ong as they are uniqgque withi shouldetme Aiphot o:
patient photos a3PEGs

2.2.1.2 Montaging

When implementing a montageeantace, systesshall provide the user with a ground source. Systems shall always
refer to this i mpl i edshalmndainchidt it s the soaree lish sThefgGMM® source shall
always be zero, i.e. GNDC3 is equivalent to D C3.

Systems shall provide the minimal setdaf- andhigh-frequencyfilters specified irg83.1.5and83.1.6respectively.
These filers shall support the following discrete set of sampling frequencies (in Hz) typically used in PSG and EEG
studies:

1 5 10

25 50 100
200 250 256
500 512 1,000
10,000

Systemsshouldalso provide both 50 Hz and 60 Hz notch fikdor sampling freqancies in the above set greater
than or equal to 200 Hz.

Systens s hal | ignore filter settings for signals sampl ed
Implementers may choose how to handle invdiiter cutoff frequency and signal sampy frequency
combinations. For instance, an implementer may choose to use a null filter to zero a channel if the montage
specifies a 53 Hipw-frequencyfilter on a 25 Hz signal Likewise, an implementer may choose to use an identity

filter if the montae specifies a 35 Haigh-frequencyfilter on a 25 Hz signal.

2.2.2 Header Requirements
A level 2 compliant format shall adhere to all requiremengid.2as well as the following requirements.

2.2.2.1 Instantaneous Event

TheInstantaneous Eveentity is the common basis for events that do not have duration.
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<Instantaneous Event >
<xdf:Time > 2008-07-015T22: 05:00 .123 - 04:00 </xdf:Time>

</ Instantaneous Event >

Figure 91 Instantaneous Event

Data Type: Date/Time

Cardinality: Required

Default: No default

Description: Specifieghe date and time at which the event occurred

2.2.2.2 Nonrinstantaneou&vent

TheNoninstantaneous Eveentity is the common basis for events that have duration.

<Non- instantaneous Event >
<! -- Instantaneous Event Information - >
<xdf:Duration > 5 </xdf:Duration>

</ Non- instantaneous Event >

Figure 107 Non-instantaneous Event

xdf: Duration

Data Type: Floatingpoint

Cardinality: Required

Default: No default

Description: Specifiesthe duration of the ent
2.2.2.3 Staff

The Staffentity is the common basis for information about staff members.
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<Staff Member >
<xdf:F irstName > Joe </xdf:FirstName>
<xdf:LastName > Technician  </xdf:LastName>
<xdf:MiddleName > Bob </xdf:MiddleName>
<xdf:ID > 1515 </xdf:ID>
<xdf:WorkPhone > 1|352|555
<xdf:Pager />
<xdf:Fax />
<xdf:CellPhone />
<xdf:Email

-0000[312  </xdf:WorkPhone>

> joebob@sleeplab.com </xdf:Email>
<xdf:Specialty />

<xdf:Titlel > RPSGT </xdf:Titlel>

<xdf:Title2 />

<xdf:Title3 />

</ Sta ff Member >

Figure 117 Staff

xdf: FirstName

Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff membero6s first name.
xdf: LastName

Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff memberds | ast name.
xdf: MiddleName

Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff member6s middle name.
xdf: 1D

Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff member éds organizational
xdf: WorkPhone

Data Type: Phone Number

Cardinality: Optional

Default: No defaut

Description: The staff memberés work phone nun
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xdf: Pager

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The staff memberdéds pager number
xdf: Fax

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The staff memberdéds fax number

xdf: CellPhone

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The staff member6s cell phone nun
xdf: Email

Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff member 6s email address.
xdf: Specialty

Data Type: Text

Cardinality: Optional

Default: No default

Description: The staff memberds specialty.
xdf: Titlel

Data Type: Text

Cardinality: Optional

Default: No default

Description: Freeform staff memberitie.
xdf: Title2

Data Type: Text

Cardinality: Optional

Default: No default

Description: Freeform staff member title.
xdf: Title3

Data Type: Text

Cardinality: Optional

Default: No default

Description: Freeform staff member title.
2.2.2.4 xdf:OpenXDF Entity
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xmins:...
>
<!-- Levell Information
<xdf:Patientinformation />
<xdf:NoteLog />
<xdf:Video />
</xdf:OpenXDF>

<xdf:OpenXDF xmins:xdf= " http://www.openxdf.org/xdf

xmins:custom= " organization/custom

= >

Figure 127 xdf:OpenXDF Entity; Level 2

xdf: PatientInformation

Data Type: Patientinformatiorentity

Cardinality: Optional

Default: No default

Description: Specifies information about the patient.

xdf: NoteLog

Data Type: List of Note entities; [0, D)

Cardinality: Optional

Default: No default

Description: Defines a global list of annotations.

Data Type: Video entity

Cardinality: Optional

Default: No default

Description: Specifies information about associated video clips.

2.2.2.5 xdf:DataFile Entity

————————————————————————————————————————————————————————————————————————————————————————————————————————————————————————————

<xdf:DataFile>
<! -- Level 1 Information
<xdf:Montages />
<xdf:RevMontages />

</xdf:DataFile>

Figure 137 xdf:DataFile Entity; Level 2

xdf: Montages

Data Type: List of Montageentities; [0, D)

Cardinality: Optional

Default: No default

Description: Defines a list of montages used during recording.
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xdf: RevMontages

Data Type: List of Montageentities; [0, D)

Cardinality: Optional

Default: No default

Description: Defines a list of display montages used during review. Unlike reco
montages, it is generally acceptable to only keep the last used review mo

2.2.2.6 xdf:Session Entity

<xdf:Session>
<! --  Level 1 Information - >
<xdf:SyncMarkers />

</xdf:Session>

Figure 1471 xdf:Session Entity; Level 2

xdf: SyncMarkers

Data Type: List of SyncMarkerentities;] 0, + D)
Cardinality: Optional

Default: No default

Description: Defines a list of data synchronization markers.

2.2.2.7 xdf:Montage Entity

<xdf:Montage>
<xdf:EffectiveTime > 2008-07-15T22:00:00 .250 - 04:00 </xdf:EffectiveTime>
<xdf:Chann els />

</xdf:Montage>

Figure 157 xdf:Montage Entity

xdf: EffectiveTime

Data Type: Date/Time

Cardinality: Required

Default: No default

Description: The date and timet avhich the montage took effect.

xdf: Channels

Data Type: List of Channelentities; [0, D)
Cardinality: Optional

Default: No default

Description: Defines a list othannels

2.2.2.8 xdf:Channel Entity
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<xdf:Channel>
<xdf:G1 > C3 </xdf:.G1>
<xdf:G2 > A2 </xdf:G2>
<xdf:Label > CB3/A2 </xdf:Label> !
<xdf:Sensitivity > 7 <Ixdf:Sensitivity> :
<xdf:HF > 0.531 </xdf:HF>
<xdf.LF > 35 </xdf:LF>

</xdf:Channel>

____________________________________________________________________________________________________________________________

Figure 161 xdf:Channel Entity; Level 2

Data Type: Text

Cardinality: Optional

Default: iGNDO

Description: Specifies tle source to whicbystems shall referen€&2.
xdf: G2

Data Type: Text

Cardinality: Optional

Default: iGNDO

Description: Specifies the G2 source for the channel.
xdf: Label

Data Type: Text

Cardinality: Optional

Default: The system shall choose a default label that includes the names of the ¢

specified by G1 and G2.
Description: Specifies a label for the channel.

xdf: Sensitivity

Data Type: Sensitinty
Cardinality: Optional
Default: 0
Description: Specifies the channel sensitivity.
xdf: LF
Data Type: Low Frequency Filter
Cardinality: Optional
Default: 0
Description: Specifies théow frequencyfilter for the channel.
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xdfnqk

Data Type: High Frequency Filter

Cardinality: Optional

Default: 0

Description: Specifies thenigh frequencyilter for the channel.

2.2.2.9 xdf:PatientinformatiorEntity
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<xdf:PatientInformation>
<xdf:FirstName > Tim </xdf:FirstName>
<xdf:LastName > Newnan </xdf:LastName>
<xdf:MiddleName > John </xdf:MiddleName>
<xdf:ID > 111-22-3333 </xdf:ID>
<xdf:DOB > 1979-04- 22 </xdf:DOB>
<xdf:Gender > male </xdf:Gender>
<xdf:Weight > 200 </xdf:Weight>
<xdf:WeightUni  ts > |b </xdf:WeightUnits>
<xdf:Height > 71 </xdf:Height>
<xdf:HeightUnits > in  </xdf:HeightUnits>
<xdf:DominantHand > right  </xdf:DominantHand>
<xdf:Street > 111 MagnoliaP lace </xdf:Street>
<xdf:City > Gainesville </xdf:City>
<xdf:State > FL </xdf:State>
<xdf:Country > United States </xdf:Country>
<xdf:ZipCode > 32608 </xdf:ZipCode>
<xdf:HomePhone > 1|352|555 -0001 </xdf:HomePhone>
<xdf:WorkPhone > 1|352|555 -0002|312 </xdf:WorkPhone>

<xdf:EmergPhone />

<xdf:Technician />
<xdf:Referring />
<xdf:Ordering />
<xdf:Reading />
</xdf:PatientInformation>

<xdf:Fax />

<xdf:Pager />

<xdf:CellPhone />

<xdf:Email />

<xdf:Codes > 327.23, 333.94 </xdf:Codes>

<xdf:Comment s> This is a comment. </xdf:Comment s>

<xdf:TestDescription > Tested for sleep disorders. </xdf:T estDescription>
<xdf:Medication> Ambien, Coumadin  </xdf:Medication>

<xdf:Interpretation > Patient had abnormal sleep. </xdf:Interpretation>
<xdf:Recommendation s> Patient needs CPAP. </xdf:Recommendations>
<xdf:FollowupPlans > Will followup with CPAP study.  </xdf:FollowupPlans>
<xdf:PatientOpinion > Patient concerned about CPAP tolerance.

<xdf:Physician />

</xdf:PatientOpinion>

Figure 1771 xdf: Patientinformation Entity

xdf: FirstName

Data Type: Text

Cardinality: Optional

Default: No default

Description: The patientds st name.
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xdf: LastName

Data Type: Text

Cardinality: Optional

Default: No default

Description: The patientds | ast name.
xdf: MiddleName

Data Type: Text

Cardinality: Optional

Default: No default

Description: The patientds middl e name.

Data Type: Text

Cardinality: Optional

Default: No default

Description: The patientods organizational | D.
xdf: DOB

Data Type: Date

Cardinality: Optional

Default: No default

Description: The patientb6s date of birth.
xdf: Gender

Data Type: Gender

Cardinality: Optional

Default: No default

Description: The patientods gender .
xdf: Weight

Data Type: Floatingpoint

Cardinality: Optional

Default: 0.0

Description: The patientods weight
xdf: WeightUnits

Data Type: Weight Unit

Cardinality: Optional

Default: il bo

Description: Weight measurement unit.
xdf: Height

Data Type: Floatingpoint

Cardinality: Optional

Default: 0.0

Description: The patientds height
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xdf: HeightUnits

Data Type: Height Unit
Cardinality: Optional
Default: Aino
Description: Height measurement unit.
xdf: DominantHand
Data Type: Dominant Hand
Cardinality: Optional
Default: No default
Description: The patientds dominant hand.
Data Type: Text
Cardinality: Optional
Default: No default
Description: The patientbds street address.
xdf: City
Data Type: Text
Cardinality: Optional
Default: No default
Description: The patientbds city of residence
xdf: State
Data Type: Text
Cardinality: Optional
Default: No default
Description: The patientbds state of residence
xdf: Country
Data Type: Text
Cardinality: Optional
Default: No default
Description: The patientds country of residenc
xdf: ZipCode
Data Type: Text
Cardinality: Optional
Default: No default
Description: The patientds postal code.
xdf: HomePhone
Data Type: Phone Number
Cardinality: Optional
Default: No default
Description: The patientds home phone number.
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xdf: WorkPhone

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The patientds work phone number .

xdf: EmergPhone

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: Themti ent s emergency contact pho

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The patientbés fax number.
xdf: Pager

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The patientbds pager number

xdf: CellPhone

Data Type: Phone Number

Cardinality: Optional

Default: No default

Description: The patientds cel l phone number.
xdf: Email

Data Type: Text

Cardinality: Optional

Default: No default

Description: The patientbds email address.
xdf: Codes

Data Type: Text

Cardinality: Optional

Default: No default

Description: Defines a commaeparated list of diagnosis codes.

xdf: Comment

Data Type: Text

Cardinality: Optional

Default: No default
Description: Freeform comment.
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: TestDescription

|
o
—

xdf:

Data Type: Text

Cardinality: Optional

Default: No default

Description: Freeform description of the test.

Medication

Data Type: Text

Cardinality: Optional

Default: No default

Description: Defines a commaeparated list of medications.

xdf: Interpretation

Data Type: Text

Cardinality: Optional

Default: No default

Description: Freeform interpretation of the test.
xdf: Recommendation

Data Type: Text

Cardinality: Optional

Default: No default

Description: Freeform recommendations
xdf: FollowupPlans

Data Type: Text

Cardinality: Optional

Default: No default

Description: Freeform follow-up plans
xdf: PatientOpinion

Data Type: Text

Cardinality: Optional

Default: No default

Description: Freeform patient opinion about the test.
xdf: Physician

Data Type: Staff entity

Cardinality: Optional

Default: No default

Description: Specifies information about the p
xdf: Technician

Data Type: Staff entity

Cardinality: Optional

Default: No defailt

Description: Specifies information about the technician that ran the test.
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xdf: Referrin

Data Type: Staff entity

Cardinality: Optional

Default: No default

Description: Specifiesinfomat i on about the patientos

xdf: Ordering

Data Type: Staff entity

Cardinality: Optional

Default: No default

Description: Specifies information about the physician thateyed the test.
Data Type: Staff entity

Cardinality: Optional

Default: No default

Description: Specifies information about the physician that read the test.

2.2.2.10xdf:Note Entity

<xdf:Note>
<! -- Instantaneous Event
<xdf:NoteText
</xdf:Note>

Figure 187 xdf:Note Entity

xdf: NoteText

| nformation - >
> Lights -out </xdf:NoteText>

Data Type: Text

Cardinality: Required

Default: No default
Description: Freeform annotation.

2.2.2.11xdf:Video Entity

<xdf:Video>
<xdf:VideoClips />
<xdf:NoteLog />

</xdf:Video>

_____________________________________

Figure 197 xdf:Video Entity

xdf: VideoClips

Data Type: List of VideoClip entities; [0, D)
Cardinality: Optional

Default: No default

Description: Defines a list of associated video clips.
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xdf: NoteLog

2.2.2.12xdf:VideoClip Entity

Data Type: List of Noteentities; [0, D)
Cardinality: Optional

Default: No dehult

Description: Defines a list of video annotations.

<xdf:VideoClip>
<! -- Non- instantaneous Event Information - >
<xdf:ClipFile > video/clipl.wmv </xdf:ClipFile>

<xdf:ClipComment

</xdf:VideoClip>

> Seizure Event </xdf:Cl ipComment>

____________________________________________________________________________________________________________________________

Figure 207 xdf:VideoClip Entity

xdf: ClipFile

xdf:

Data Type: Text

Cardinality: Required

Default: No default

Description: The video clip file name.To avoid path convention issuasross platforms
systems should avoidbsolute and/ocomplex paths such as UNgaths and
URLs. Systems shall attempt to translate between Windows and P
conventions where possible.

ClipComment

Data Type: Text

Cardinality: Optional

Default: No default

Description: Freeform comment.

2.2.2.13xdf:SyncMarker Entity

</xdf:SyncMarker>

<xdf:SyncMarker>
<! -- Instantaneous Event
> 0.0012 </xdf:SyncDelta>

<xdf:SyncDelta

Information - >

Figure 217 xdf:SyncMarker Entity
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xdf: SyncDelta

Data Type: Floatingpoint

Cardinality: Required

Default: No default

Description: Indicates acquition device drift in seconds. A positive value indicates tha

acquisition device was running faster than its nominal sampling rate
negative value indicates that the acquisition device was running slower tf
nominal sampling rate.

2.3 Level 3.55G

2.3.1 System Requirements

A level 3.PSG compliant system shall adhere to all requiremeg&arilas well as the following requirements.
2.3.1.1 Packaging

Systems may p&age scoring resultsito secondary headers under a packhder e ct or y noa meTdh el sfciolr e
names of the secondary headers may be arbitrary but sh
header may contain one or ma@orershowever,the scorer IDs shall be unique across all secondary headers in the

package

2.3.2 Header Requirements
A level 3.PSGcompliant format shall adhere to all requirement8Zr2.2as well as théollowing requirements.
2.3.2.1 Respiratory Event

TheRespiratory Evengntity is the common basis for classified respiratory events.

<Respiratory Event >
<! -- Non- instantaneous Event Information - >
<xdf:Class > obstructive </xdf:Cl ass>

</ Respiratory Event >

Figure 221 Respiratory EvenEntity

xdf: Class

Data Type: Respiratory Class

Cardinality: Required

Default: No default

Description: Specifiesthe respiratory event class.

2.3.2.2 xdf:OpenXDF Entity
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<xdf:OpenXDF xmins:xdf=
xmins:custom=
xmins:...
>
<! --  Level 2 Information
<xdf:ScoringResults />
</xdf:OpenX DF>

" http://www.openxdf.org/xdf

" organization/custom

Flgure 2371 xdf:OpenXDF Entity; Level 3.PSG

xdf: Scoringresults . .

Data Type: ScoringResultentity
Cardinality: Optional

Default: No default

Description: Specifies scoring results.

2.3.2.3 xdf:Channel Entity

<xdf:Channel>

<l --  Level 2 Information

=

<xdf:Type > Pressure </xdf:Type>

</xdf:Channel>

Flgure 2471 xdf:Channel Entity; Level 3.PSG

xdf: Type

Data Type: Channel Type
Cardinality: Optional
Default: No default
Description: Channel type

2.3.2.4 xdf:ScoringResults Entity

<xdf:ScoringResults />
<xdf:Epochinformation />
<xdf:Scorers />

</xdf:ScoringResults />

____________________________________________________________________________________________________________________________

Flgure 257 xdf:ScoringResults Entity

xdf: Epochinformation

Data Type: List of Epochentities; [0, D)

Cardinality: Optional

Default: No default

Description: Defines a list of scorendependent epoch information.
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xdf: Scorers

Data Type: List of Scorerentities; [0, D)
Cardinality: Optional

Default: No default

Description: Defines a list of scorers.

2.3.2.5 xdf:Epoch Entity

<xdf:Epoch>
<xdf:EpochNumber > 546 </xdf:EpochNumber>
</xdf:Epoch>

____________________________________________________________________________________________________________________________

Figure 267 xdf:Epoch Entity

xdf: EpochNumber

Data Type: UlInt32

Cardinality: Required

Default: No default

Description: Specifies the epoch number to which this information applies.

2.3.2.6 xdf:Scorer Entity

————————————————————————————————————————————————————————————————————————————————————————————————————————————————————————————

<xdf:Scorer>
<xdf:ScorerlD > 9BC7C81D 9D2D- 4685 - BOSE- 0B334F858299 </xdf:ScorerlD>
<xdf:FirstName > Alice </xdf:FirstName>
<xdf:LastName > de S corer </xdf:LastName>
<xdf:SleepStages />
<xdf:Apneas />
<xdf:Hypopneas />
<xdf:Desaturations />
<xdf:Microarousals />
<xdf:Sno res />
<xdf:LegMovements 1 />
<xdf:LegMovements2 />
<xdf:RERAs />
<xdf:NoteLog />

</xdf:Scorer>

'
b o o o o o o o o o e o e e e e e e e e e e e e e e e e e e e e e e e e e e e |

Figure 2771 xdf:Scorer Entity

xdf: ScorerlD

Data Type: uulD

Cardinality: Required

Default: No default

Description: Specifies a universally unique ID for the scorer.
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xdf: FirstName

Data Type: Text

Cardinality: Optional

Default: No default

Description: The scorerbds first name.
xdf: LastName

Data Type: Text

Cardinality: Optional

Default: No default

Description: The scorerdés | ast name.

xdf: SleepStages

Data Type: List of SleepStagentities; [0, D)

Cardinality: Optional

Default: No default

Description: Defines a list of sleep stages.
xdf: Apneas

Data Type: List of Apneaentities; [0, D)

Cardinality: Optional

Default: No default

Description: Defines a list of apneas.

xdf: Hypopneas

Data Type: List of Hypopneeentities; [0, D)
Cardinality: Optional

Default: No default

Description: Defines a list of hypopneas.

xdf: Desatuations

Data Type: List of Desaturatiorentities; [0, D)
Cardinality: Optional

Default: No default

Description: Defines a list of O2 desaturations.

xdf: Microarousals

Data Type: List of Microarousakentities; [0, D)

Cardinality: Optional

Default: No default

Description: Defines a list of microarousals.
xdf: Snores

Data Type: List of Snoreentities; [0, D)

Cardinality: Optional

Default: No default

Description: Defines a list of snores.
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:LegMovements

|
o
—

Data Type: List of LegMovemengentities; [0, D)

Cardinality: Optional

Default: No default

Description: Defines a list of leg movements the first leg channel

xdf:.LegMovements2

Data Type: List of LegMovemenernt i ti es; [0, +D)
Cardinality: Optional

Default: No default

Description: Defines a list of leg movements on the second leg channel
Data Type: List of RERA entities; [0, D)

Cardinality: Optional

Default: No default

Description: Defines a list of RERASs.

xdf: NoteLog

Data Type: List of Note entities; [0, D)

Cardinality: Optional

Default: No default

Description: Defines a list obcorerdependent annotations.

2.3.2.7 xdf:SleepStage Entity

<xdf:SleepStage>
<xdf:EpochNumber > 342 </xdf:EpochNumber>
<xdf:Stage > R </xdf:Stage>
</xdf:SleepStage>

Figure 281 xdf:SleepStage Entity

xdf: EpochNumber

Data Type: UlInt32

Cardinality: Required

Default: No default

Description: The epoch number to which this sleep stage applies.
Data Type: Sleep Stage

Cardinality: Optional

Default: i N o

Description: Specifies the sleep stage for this epoch.

2.3.2.8 xdf:Apnea Entity
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<xdf:Apnea>
<! --  Respiratory Event Information - >
</xdf:Apnea>

Flgure 2971 xdf:Apnea Entity

2.3.2.9 xdf:Hypopnea Entity

<xdf:Hypopnea>
<! -- Respiratory Event Information - >

</xdf:Hypopnea>

Flgure 3071 xdf:Hypopnea Entity

2.3.2.10xdf:Desaturation Entity

<xd f:Desaturation>
<!I'-- Non- instantaneous Event Information - >

</xdf:Desaturation>

Flgure 317 xdf:Desaturation Entity

2.3.2.11xdf:Microarousal Entity

<xdf:Microarousal>
<! -- Non- instantaneous Event Information - >

</xdf:Microarousal>

Flgure 3271 xdf:Microarousal Entity

2.3.2.12xdf:Snore Entity

————————————————————————————————————————————————————————————————————————————————————————————————————————————————————————————

<xdf:Snore>
<!'-- Non- instantaneous Event Information - >

</xdf:Snore>

Flgure 331 xdf:Snore Entity

2.3.2.13xdf:LegMovement Entity

<xdf:LegMovement>
<!I'-- Non- instantaneous Event Information - >

</xdf:LegMovement>

Flgure 347 xdf:.LegMovement Entity



2.3.2.14xdf:RERA Entity

————————————————————————————————————————————————————————————————————————————————————————————————————————————————————————————

<xdf:RERA>
<! -- Non- instantaneous Event Information - >
</xdf:RERA>

Figure 351 xdf:RERA Entity

3l|Page



3 Data Types

3.1.1 Fundamental Data Types

Type Range

Boolean { Atrued, Afal seod
(S/U)Int8 (S)igned/(U)nsigned 8 bits

(S/U)Int16 (S)igned/(U)ssigned 16 bits
(S/U)Int32 (S)igned/(U)nsigned 32 bits
(S/U)Int64 (S)igned/(U)nsigned 64 bits
Floatingpoint Platform specific

3.1.2 Endian Type

The Endian type describes the byte order of a rhylie value. Little endian valugzocee from the least
significant byte to thenost significantwhereabig endian valueproceedrom the mosssignificant byte to théeast
significant The Endian typenaybe one of the following values:

Abi go Alittleod

3.1.3 Date/Time Type

A date/time value shall adhere to the following subs¢B6f 8601

A time shallbe qualified with a date; however, a date does not have to include a timelaté doesot include a
time, the time shall default to 00:00:00 UTC

Dates always include four digit years and leading zeros on the month andAdayd a ©86) (sfe phayeart es t
month, and day

Systems shall pay particular attention to the ability to reptesditrary dates using 1ISO 860B5ystens may not
rely on an internal date/time representation that uségring epoclor is limited in range to theearfuture

A date and the char act e3ystdms shallaltvayd specifyne wloesind 2-hourifomeat v al ue s
with leading zeros on the hour, minute, and second. Fractionsesbadsmay be expres$using a decimal point
( A afienthe secondsA c ol on ( Ahedgur, mirue,andsdcand. t

Systems shall support up émemicrosecond precision.

Tmeaone offsets Dtharacter fallowedby thetoffsetdaurs &nd minutes with leading zeros and

separated by a f:o0. Usi ng f Zdordinated Wnwveasdl Timé (UEC)Ifatinme z one
does not include eithen offseora fZ0 character, the time zone shalll def
fi2008- 07- 150 ...oovveeeerecereerrenens 00:00:00 +000 ms AM UTC,July 15,200 8
fi2008- 07- 15T22:00:0 0.000250 0 .............. 10:00:0 0 +250 us PMUTC,July 15,200 8
fi2008- 07- 15T22:00:0 0.000250Z 6 ............. 10:00:0 0 +250 us PMUTC,July1l 5,200 8
fi2008- 07- 15T22:00: 00.250 - 04:00 O ........... 10:00:0 0 +250 msPMEDT/CST,Julyl 5,200 8

Figure 3617 Example Date/Time Values
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3.1.4 Sensitivity Type

Traditionally, this value would spdygithe sensitivity in uV / mm. Systems shall interpret this value as simply a
divider. A sensitivity of zero indicates that the system should zero the channel.

Systems shall support the following values typically used in PSG and EEG studies:

0 1 2

3 5 7
10 15 20
30 40 50
75 80 100
150 200

3.1.5 Low FrequencyFilter Type

Systens shall support the followingow frequencycutoffs (in Hz) typically used in PSG and EEG studiasd
specified by the AASM

0.032 0.053 0.1
0.159 0.3 0.531
1.592 5.305 10
15.916 53.052

Some of hese values represent the typical sdbatfrequencyfilter time constants, whiclre:5s, 3s, 1s, 0.3s, 0.1s,
0.03s,and 0.003s.

B 1
2.7 f

cutoff

T

Figure 371 Time Constant / Cutoff Frequency Relationship

3.1.6 High FrequencyFilter Type

Systens shall support the followingigh frequencycutoffs (in Hz)typically used in PSG and EEG studies:

15 30 35
60 70 100

3.1.7 Gender Type

Gender may be one of the following values:

fimal eo if emal eo
3.1.8 Weight Unit Type

The weight unit may be one of the following values:

| Al bo ikgo
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3.1.9 Height Unit Type

The heighunit may be one of the following values:
|fAino ficmo

3.1.10 Dominant Hand Type

The dominant hand may be one of the following values:
|l efto iri ghto

3.1.11 Phone Number Type

The phone number type is a text vatbat contains the country code, area codbsesriber number, and extension
separated by the pipe (A] 0) character.

————————————————————————————————————————————————————————————————————————————————————————————————————————————————————————————

A1[352|555 - 0000] 3120 .ooocovovvveerenee, +1(352) 555 - 0000 X312
! A39]06|12345678[312 O ovcoorvvvecieens +39 06 12345678 x312 '
f44]20|12345678(312 O ovvccvovvveern +44 20 12345678 x312

Flgure 381 Example Phone Numbers
3.1.12 UUID Type

The UUID type is aJniversally Unique Identifier that adheresR&C 4122

fiI9BC7C81D- 9D2D- 4685 - BOSE- 0B334F858299 0
fi873491BA- 5A2C- 407F - B608- A0O2DA601D0760
fiIB63CA4D8 F74F- 4ADDB- A9A3- 82EOD1E4F5170

Flgure 3971 Example UUIDs

3.1.13 Channel Type

The channel type serves two purposes. First, it indicates where reading ssfsbeidslisplay each type of event.
Second, it serves as a hint for computer scoring system as to how the skstddinterpret the channel. The
channel type may be one of the following values:

ACentralo AOccipitalo AFrontal o

AEOG10 AEOG20 AEKG10

AEKG20 AEKG3 AChino

ALeglo ALeg?20o A T h ed(Thermister)

ﬁ P r.@(Bressure Transducer) i C. F (G APOFlow) fi C h e(GhesbEffort)
bdomer (Abdominal Effort) iSaO020 iSnoreo

i B o dBody Position) APul sed AEt CO20

i R RR-to-R Interval) ApHO fi B RBlood Pressune

fi P T (Palse Transit Time) fi C P A(BRAP Pressure)

Reading systemshoulddisplay events according to the followinges
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Event Type Channel Type

Apneas Systemsshoulddisplay apneas on the Thernaisthannel. If a Thermist channel is not
presenin the montage, systems may display apneas on the Pressure channel if preg

Hypopneas Systemsshoulddisplay hypopneas on the Pressure channel. If a Pressure channg
present in the montage, systems may display hypopneas on the Téreomésnel if
present.

RERAs Systemsshoulddisplay RERASs in the same manner as hypopneas.

Leg Movements

Systemsshoulddisplay leg movements on either the Legl or Leg2 channel dependi
the leg movement list in which the event exis{gdf:LegMovementsl o
xdf:LegMovements2).

Snores

Systemsshoulddisplay snores on the Snore channel.

Desaturations

Systemsshoulddisplay desaturations on the SaO2 channel.

Microarousals

Systemsshoulddisplay microarousals on amyailableEEG or EOG channel (Centrg
Occipital, Frontal, EOG1, or EOG2).

3.1.14 Sleep Stage Type

The sleep stage typeay be one of the following values

Al1o [/ oBAASMINL 1 20 [/ OBAASMINZ 2 30 [/ OoBAASMIN3 3
40 /| OBAASMIN3 4 AiR0O / REM AAOG |/ Adtivef ant
ATo / I nfant TrafAQo / I nfant Qui AWO / Wake
AMO / Movement ALO /-ohight s iTRO {in-Réanc h
AiNOo -flataNo ANRO / AASMRHM1f a

3.1.15 Respiratory Class Type

The respiratory clagmay be one of theoflowing values

|Aobstructiveo fimi xedo ficentral o
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4 Putting It All TogetherA Full Example

<?xml version="1.0" encoding="utf -8" 7>
<xdf:OpenXDF xmins:xdf="http://www.openxdf.org/xdf"
xmins:custom="http://www.example.org/custom">
<xdf:Epo chLength> 30 </xdf:EpochLength>
<xdf:SessionContinuity> false  </xdf:SessionContinuity>
<xdf:Patientinformation>
<xdf:FirstName> Tim </xdf:FirstName>
<xdf:MiddleName> John </xdf:MiddleName>
<xdf:LastName>  Newnan </xdf:LastName>
<xdf:ID>  111-22-3333 </xdf:ID>
<xdf:DOB> 1979-04-22 </xdf:DOB>
<xdf:Gender> male </xdf:Gender>
<xdf:Weight> 200 </xdf:Weight>

<xdf:WeightUnits> b </xdf:WeightUnits>
<xdf:Height> 71 <Ixdf:Height>
<xdf:HeightUnits> in  </xdf:HeightUnits>

<xdf:DominantHand> right  </xdf:DominantHand>
<xdf:Street> 111 Magnolia Place </xdf:Street>
<xdf:City> Gainesville </xdf:City>

<xdf:State> FL </xdf:State>

<xdf:Country> United States </xdf:Country>
<xdf:ZipCode> 32608 </xdf:ZipCode>

<xdf:HomePhone> 1|352|555 -0001 </xdf: HomePhone>
<xdf:WorkPhone>  1|352|555 -0002|313 </xdf:WorkPhone>

<xdf:EmergPhone />

<xdf:Fax />

<xdf:Pager />

<xdf:CellPhone />

<xdf:Email />

<xdf:Codes> 327.2 3,333.94  </xdf:Code s>

<xdf:Comment> This is a comment. </xdf:Comment>

<xdf:TestD escription> Tested for sleep disorders. </xdf:TestDescription>
<xdf:Medication> Ambien, Coumadin  </xdf:TestDescription>

<xdf:Interpretation> Patient had abnormal sleep. </xdf:Interpretation>
<xdf:Recommendation> Patient needs CPAP. </xdf:Recommendati  on>
<xdf:FollowupPlans> Will followup with CPAP study. </xdf:FollowupPlans>
<xdf:PatientOpinion> Patient concerned about CPAP tolerance. </xdf:PatientOpinion>
<xdf:Physician />

<xdf:Technician>
<xdf:FirstName> Joe </xdf:FirstName>



<xdf:Middle ~ Name> Bob </xdf:MiddleName>
<xdf:LastName>  Technician  </xdf: LastName >
<xdf:ID> 1515 </xdf:ID>
<xdf:WorkPhone>  1|352|555 -0000|312 </xdf:WorkPhone>
<xdf:Pager />
<xdf:Fax />
<xdf:CellPhone />
<xdf:Email> joebob@sleeplab.com </xdf:Email>
<xdf:Specialty />
<xdf:Title1> RPSGT </xdf:Title1>
<xdf:Title2 />
<xdf:Title3 />
</xdf:Technician>
<xdf:Referring />
<xdf:Ordering />
<xdf:Reading />
</xdf:PatientInformation>
<xdf:NoteLog>
<xdf:Note>
<xdf:Time> 2008- 07- 15T22:05: 00.123 - 04:00 </xdf:Time>
<xdf:NoteText> Lights -out </xdf:NoteText>
</xdf:Note>
<xdf:Note>
<xdf:Time>  2008- 07- 15T22:15:00.639 - 04:00 </xdf:Time>
<xdf:NoteText> Lights -on </xdf:NoteText>
</xdf:Note>
</xdf:NoteLog>
<xdf:Video>
<xdf:VideoClip s>
<xdf:VideoClip>
<xdf:Time> 2008- 07- 15T22:00: 00. 250- 04:00 </xdf:Time>
<xdf:Duration> 20 </xdf:Duration>
<xdf:ClipFile> video/clipl.wmv </xdf:ClipFile>
<xdf:ClipComment> Seizure Event </xdf:ClipComment>
</xdf:VideoClip>
</xdf:Video  Clips>
<xdf:NoteLog />
</xdf:Video>
<xdf:DataFiles>
<xdf:DataFile>
<xdf:File> EXAMPLE.RAWDAT A/xdf:File>
<xdf:FrameLength> 1 </xdf:FramelLength>
<xdf:Endian> big </xdf:Endian>
<xdf:Sources>
<xdf:Source>
<xdf:Ignore> false  </xdf:l  gnore>
<xdf:SourceName>  C3 </xdf:SourceName>



<xdf:SampleWidth> 2 <Ixdf:SampleWidth>
<xdf:Signed> true  </xdf:Signed>
<xdf:SampleFrequency> 1000 </xdf:SampleFrequency>

<xdf:DigitalMax> 32767 <Ixdf:DigitalMax>
<xdf:DigitalMin> - 32768 <Ixdf:DigitalMin>
<xdf:PhysicalMax> 3200 </xdf:PhysicalMax>
<xdf:PhysicalMin> - 3200 </xdf:PhysicalMin>
<xdf:DigitalToVolts> 0.09765774  <Ixdf:DigitalToVolts>

<xdf:Unit> 0.000001  </xdf:Unit>

</xdf:Source>

<xdf:Source>

<xdf:lgnore> false  </xdf:Ignore>

<xdf:SourceName>  C4 </xdf:SourceName>
<xdf:SampleWidth> 2 <Ixdf:SampleWidth>
<xdf:Signed> true  </xdf:Signed>
<xdf:SampleFrequency> 1000 </xdf:SampleFrequency>

<xdf:DigitalMax> 32767 <Ixdf:DigitalMax>
<xdf:DigitalMin> - 32768 <Ixdf:DigitalMin>
<xdf:PhysicalMax> 3200 </xdf:PhysicalMax>
<xdf:PhysicalMin> - 3200 </xdf:PhysicalMin>
<xdf:DigitalToVolts> 0.09765774  <Ixdf:DigitalToVolts>

<xdf:Unit> 0.000001  </xdf:Unit>

</xdf:Source>

<xdf:Source>

<xdf:lgnore> false  </xdf:Ignore>

<xdf:SourceName> Al </xdf:SourceName>
<xdf:SampleWidth> 2 <Ixdf:SampleWidth>
<xdf:Signed> true  </xdf:Signed>
<xdf:SampleFrequency> 1000 </xdf:SampleFrequency>

<xdf:DigitalMax> 32767 <Ixdf:DigitalMax>
<xdf:DigitalMin> - 32768 </xdf:DigitalMin>
<xdf:PhysicalMax> 3200 </xdf:PhysicalMax>
<xdf:PhysicalMin> - 3200 </xdf:PhysicalMin>
<xdf:DigitalToVolts> 0.09765774  <Ixdf:DigitalToVolts>

<xdf:Unit> 0.000001  </xdf:  Unit>

</xdf:Source>

<xdf:Source>

<xdf:Ignore> false  </xdf:Ignore>
<xdf:SourceName>  Pressure  </xdf:SourceName>
<xdf:SampleWidth> 2 </xdf:SampleWidth>
<xdf:Signed> true  </xdf:Signed>

<xdf:SampleFrequency> 1000 </xdf:SampleFre  quency>
<xdf:DigitalMax> 32767 <Ixdf:DigitalMax>
<xdf:DigitalMin> - 32768 </xdf:DigitalMin>
<xdf:PhysicalMax> 3200 </xdf:PhysicalMax>
<xdf:PhysicalMin> - 3200 </xdf:PhysicalMin>
<xdf:DigitalToVolts> 0.09765774  <Ixdf:DigitalToVolts>



<xdf:Unit> 0.000001  </xdf:Unit>

</xdf:Source>
<xdf:Source>
<xdf:lgnore>

false  </xdf:lgnore>

<xdf:SourceName> SaO2 </xdf:SourceName>
<xdf:SampleWidth> 1 </xdf:SampleWidth>

<xdf:SampleFrequency> 1 </xdf:SampleFrequency>

<xdf:DigitalMax>
<xdf:DigitalMin>

100 </xdf:DigitalMax>
0 </xdf:DigitalMin>

<xdf:PhysicalMax> 100 </xdf:PhysicalMax>

<xdf:PhysicalMin> 0 </xdf:PhysicalMin>
<xdf:DigitalToVolts> 0.01 </xdf:DigitalToVolts>

</xdf:Source>
</xdf:Source s>
<xdf:Sessions>
<xdf:Session>
<xdf:Offset>
<xdf:Length>

<xdf:StartTime>

1000 </xdf:Offset>
9601200 </xdf:Length>
2008- 07- 15T22:00:00.250 -04:00 </xdf:StartTime>

<xdf:SyncMarkers>

<xdf:SyncMarker>

<xdf:Time>

2008- 07- 15T22:00:1 0. 250- 04:00 </xdf:Time>

<xdf:SyncDelta> 0.0012  </xdf:SyncDelta>
</xdf:SyncMarker>

<Ixdf:SyncMarkers>

</xdf:Session>
</xdf:Sessions>
<xdf:Montages>

<xdf:Montage>

<xdf:EffectiveTime> 2008-07-15T22:00:00.250 - 04:00 </xdf:EffectiveTime>

<xdf:Channels>

<xdf:Channel>

<xdf:G1 />

<xdf:G2> C3 </xdf:G2>

<xdf:Label> GND/C3 </xdf:Label>
<xdf:Sensitivity> 7 <Ixdf:Sensitivity>
<xdf:LF> 0531 </xdfiLF>

<xdf:HF> 35 </xdf: HF>

<xdf:Type />

</xdf:Channel>

<xdf:Channel>

<xdf:G1>
<xdf:G2>

<xdf:Label>

C4 </xdf:G1>
Al </xdf:G2>
Al/C4  </xdf:Label>

<xdf:Sensitivity> 7 <Ixdf:Sensitivity>

<xdf:LF>
<xdf:HF>

0.531 </xdf:LF>
35 </xdf:HF>



<xdf:Type> Central  </xdf:Type>
</xdf:Channel>
<xdf:Channel>
<xdf:G1 />
<xdf:G2> Pressure  </xdf:G2>
<xdf:Label> GND/Pressure  </xdf:Label>
<xdf:Sensitivity> 7 <Ixdf:Sensitivity>
<xdf:.LF> 0.159 </xdf:LF>
<xdf:HF> 15 </xdf:HF>
<xdf:Type> Pressure </xdf:Type>
</xdf:Channel>
<xdf:Channel>
<xdf:G2> Sa02 </xdf:G2>
<xdf:Label> Sa02 </xdf:Label>
<xdf:Sensitivity> 10 </xdf:Sensitivity>
<xdf:LF />
<xdf:HF />
<xdf:Type > SaO2 </xdf:Type>
</xdf:Channel>
</xdf:Channels>
</xdf:Montage>
</xdf:Montages>
<xdf:RevMontages />
</xdf:DataFile>
</xdf:DataFiles>
<xdf:ScoringResults>
<xdf:Epochinformation />
<xdf:Scorers>
<xdf:Scorer>
<xdf:ScorerID> 9BC7C81D 9D2D- 4685 - BOSE- 0B334F858299
<xdf:FirstName> Alice  </xdf:FirstName>
<xdf:LastName> de Scorer  </xdf:LastName>
<xdf:SleepStages>
<xdf:SleepStage>
<xdf:EpochNumber> 1 </xdf:Ep ochNumber>
<xdf:Stage> W </xdf:Stage>
</xdf:SleepStage>
<xdf:SleepStage>
<xdf:EpochNumber> 2 </xdf:EpochNumber>
<xdf:Stage> 1 </xdf:Stage>
</xdf:SleepStage>
<xdf:SleepStage>
<xdf:EpochNumber> 3 </xdf:EpochNumber>
<xdf:Stage> 1 </xdf:Stage>
</xdf:SleepStage>
<xdf:SleepStage>
<xdf:EpochNumber> 4 </xdf:EpochNumber>

</xdf:ScorerlD>



<xdf:Stage> R </xdf:Stage>
</xdf:SleepStage>
</xdf:SleepStages>
<xdf:Apneas>
<xdf:Apnea>
<xdf:Time> 2008- 07- 15T22:14:32.543 - 04:00
<xdf:Duration> 10.8 </xdf:Duration>
<xdf:Class> Obstructive </xdf:Class>
</xdf:Apnea>
</xdf:Apneas>
<xdf:Hypopneas />
<xdf:Desaturations />
<xdf:Microarousals >
<xdf:Microarousal>
<xdf:Time> 2008 - 07-15T22:12:14.873 - 04:00
</xdf:Microarousal>
<xdf:Snores />
<xdf:LegMovements 1 />
<xdf:LegMovements2 />
<xdf:RERAs />
<xdf:NoteLog />
<custom:CustomSpikeEvents>

<custom:CustomSpikeEvent>

<xdf :Time> 2008-07-15T22:06:24.683124 -04:00 </ xdf :Time>

</custom:CustomSpikeEvent>
</custom:CustomSpikeEvents>
<custom:CustomRespiratoryEvents>

<custom:CustomRespiratoryEvent>

</xdf:Time>

</xdf:Time>

<xdf:Time>  2008-07-15T22: 10:00 - 04:00 </xdf:Time>

<xdf:Duration> 15.2 </xdf:Duration>

<custom:LowestSaO2> 82 </custom:LowestSaO2>

</custom:CustomRespiratoryEvent>
</custom:CustomRespiratoryEvents>

</xdf:Scorer>
</xdf:Scorers>
</xdf:ScoringResults>
</xdf:OpenXDF>

Figure 4071 Full OpenXDF Header Example
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